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ガイドの見方
本クイックスタートガイドで使用する記号とその内容について説明します。

記号 内容 例

知っておく必要のある内容を記載
しています。

C言語コントローラユニットのプログラムの演算は，ス
イッチの状態が RUN/STOP にかかわらず実行されます。

参照マニュアルや詳細を記載して
いるページを紹介しています。

下記マニュアルを参照してください。

MELSEC-Q C 言語コントローラユニットユー
ザーズマニュアル :SH-081077

用語の説明を記載しています。
バッファメモリ：インテリジェント機能ユニット内部の

記憶領域で，C言語コントローラユ
ニットと受け渡しするデータ ( 設定値，
モニタ値など )が格納されます。

作業を行う上で必ず注意すること
を記載しています。

ユニットを取り付けるときは，必ず電源を遮断してくだ
さい。

[ ]
メニューバーのメニュー名
([ ] → [ ] はドロップダウン
 メニューを示します。)

メニュー [ プロジェクト ] → [ プロジェクトの新規作成 ]

画面のボタン ボタン

キーボードのキー キー

Point

参考

用語

F4
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はじめに
本クイックスタートガイドは，三菱シーケンサMELSEC-Q シリーズ C言語コントローラユニット
Q24DHCCPU-V( 以下 C言語コントローラユニット ) を初めて使用する場合の基本的な導入手順を，わ
かりやすく説明しています。
MELSEC-Q シリーズを初めて使用する方で，下記のような方が，C言語コントローラユニットの使い
方を簡単に理解することができるようになっています。

・C言語または C++言語プログラムのプログラミング経験がある
・マイコンボードやパソコン環境から C言語コントローラユニットを使ったシステムへの置換えを
考えている

参考

●使用上の注意事項
C言語コントローラユニットを安全に使用するために，C言語コントローラユニットユーザー
ズマニュアルの「安全上のご注意」をよく読んだ上で使用してください。

本クイックスタートガイドは，「〈2〉システムを構築する」(P.13) に示すシステム構成での操
作を前提としています。
実際にシステムを設計／運用する場合には，下記ページで紹介しているマニュアルを必ずお
読みください。

「関連マニュアル」(P.10)
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ユニットの装着や配線

動作確認

プログラムの作成

クイックスタート
ガイド

/* バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

AC100V DC24V
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C言語コントローラユニットでできること

■ 複雑かつ高速な処理や上位サーバとの通信処理
C言語コントローラユニットは，C言語または C++言語プログラムを使ってMELSEC-Q シリーズのユ
ニットの管理や入出力機器の制御を行う CPU ユニットで，下記のような用途に活用できます。
　・マイコンボードやパソコン環境で開発した C言語または C++言語プログラムの流用
　・ラダープログラムでは困難な，複雑かつ高速な情報・演算処理が必要な分野での活用 (半導体製造，

太陽電池製造，公共インフラ (電気，ガス，水道など ) 遠隔監視など )
C 言語コントローラユニットは，ユーザプログラムによって，さまざまな機能を簡単に実現できます。
また，パートナ製品を活用することで，例えば下記のような機能も簡単に実行できます。
　・SECS 通信ソフトウェアパッケージにより，半導体製造分野などでよく使われる SECS 通信にプロ
グラムレスで対応し，上位サーバとの通信もゲートウェイパソコンなしで直接実行

　・ビジョンシステムと連携し，画像識別や製品検査などをパソコンレスで実行

●半導体製造 ラダーでは
難しい

高速な情報
・演算処理が
可能

SECS通信
ゲートウェイ
にもなり
コスト・

サイズダウン

C言語
プログラム

資産が流用でき
開発コストを
削減

フィールド
ネットワークや

センサネットワークなどで
高速なデータ収集を
省配線で簡単に実現

演算・制御

SECS通信(Ethernet)

上位サーバ

データ収集
ツール設定のみで可能

サーボ
アンプとの

高速同期通信も
利用可能

●製品画像検査
ビジョン連携による画像識別

装置内のコントローラ間通信

マシン
ビジョン

Ethernet

省スペースで
耐環境性も
安心

最大1Gbpsの
高速・大容量な
コントローラ
ネットワークで
タクトタイム短縮！

画像識別・
製品検査などを
パソコンレスで
実現！
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■ 安定した情報処理能力と，高いリアルタイム性

1. ユーザプログラム実行のばらつきを抑え，安定した情報処理を実現します。
システム制御用MPUと，ユーザプログラム実行用MPUの，2つのMPUを搭載しています。
これにより，ユーザプログラムをシステム制御から独立して実行でき，システム制御の負荷状況によ
り発生するユーザプログラム実行時のバラつきを最小限に抑えられます。

2. 豊富な機能を実装し，リアルタイムな制御を実現します
C 言語コントローラユニットは，実績と信頼性のあるリアルタイムOS，VxWorks( 米国ウインドリ
バー・システムズ社製 ) を標準搭載しています。( ランタイムライセンス費用は発生しません。)
VxWorks は，プリエンティブ方式*1 によって，リアルタイムな演算処理が可能です。
そのため，パソコン環境とは異なり，割込みや定時性が求められる処理などにも確実に対応できます。
また，VxWorks は，ファイルアクセスやネットワーク機能のドライバ，入出力や通信のライブラリな
ど，豊富な機能を標準で実装しているため，さまざまな用途に即応できます。
＊ 1 複数のプログラムを実行する上で，特定のプログラムだけがプロセッサ (CPU) を専有することなく，公平に実行時間を割

り振ることができる処理方式。

システム制御負荷の
影響を受けずに

ユーザプログラムを実行

＋ ユーザプログラム
実行用MPU

データ処理、通信処理、
数値解析処理などを実行

システム制御用
MPU

MELSEC-Qシリーズ
ユニット制御を実行
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■ C 言語コントローラユニットの特長

1. MELSEC-Q シリーズの豊富なユニットで柔軟にシステム構築！
C 言語コントローラシステムでは，プログラム資産を流用できるだけではなく，MELSEC-Q シリーズ
の豊富なユニットを活用でき，システム構成の変更も簡単です。

2. OS，ドライバ，ライブラリを実装済みで，ユーザプログラム開発に専念！
C 言語コントローラユニットには，OSと通信ドライバが組み込まれています。マイコンボードやパソ
コン環境での面倒な作業 (OS 移植，ドライバ開発，ROMへのOS 書込みなど ) が不要なため，ユーザ
プログラムの開発に専念することができます。
また，MELSEC-Q シリーズの各ユニットには，C言語コントローラユニットの専用関数ライブラリに
より，簡単にアクセスできます。

ボードは
　大変だ～

マイコンボードやパソコン環境 C言語コントローラシステム

電源ユニット

入出力
ユニット
高速入力,
割込み入力，
AC/DC…
45機種以上

　高信頼
・

長期安定
供給

ボード／チップの　　生産中止

製品のライフサイクルが短い

MELSEC-Qシリーズの豊富なユニットで
柔軟にシステム構築

簡単に
スロット
イン

ハードウ
ェアの仕

様や環境

による制
約で拡張

しづらい

ハードウ
ェアの

選択肢が
少ない

システムの変更時は着脱も面倒

ベースユ
ニットも

増設でき
，拡張も

簡単

アナログ
ユニット
A/D変換，
D/A変換，
温度調節…
27機種以上

ネットワーク
ユニット
コントローラ間,
省配線,
センサ…
17機種以上

位置決め
ユニット
4軸,8軸,16軸,
パルス入力,
差動出力…
26機種以上

Q173DCPU Q173DCPU Q173DCPU

情報
ユニット など
ロギング，
MES通信,
シリアル通信…
5機種以上

マイコンボードやパソコン環境

専用ライブ
ラリ

関数で簡
単！

各ユニットへのアクセスも…

アナログ
ドライバ

I/O
ドラ
イバ

ネットワーク
ドライバ

ネットワーク
ボード

I/O
ボー
ド

アナログ
ボード

C言語コントローラシステム

ユーザ
プログラム

ライブ
ラリ

ライブ
ラリ ライブラリ

OS (システム構成
によって変更)

ユーザ
プログラム

作成はユー
ザ

プログラム
のみ！

アナログ
ドライバ

I/O
ドラ
イバ

ネットワーク
ドライバ

ライブ
ラリ

ライブ
ラリ ライブラリ

OS (VxWorks)

実装
済み

簡単！
早期立上げ！

OS作成，ボ
ードごと

にドラ

イバとラ
イブラリ

を作成…

システムが変わったらまた作り直し…

工数大！
面倒！

/＊ y出力データを書込む ＊/
sRet＝QBF_Y_Out_BitEx(IPath,  0,  i,  1);

YY出力出力Y出力
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3. 初期化やパラメータ設定，モニタ・テストが，プログラムレスで可能！
C 言語コントローラユニットの初期化，システム設定，ネットワークユニットのパラメータ設定など
のために，複雑なプログラムを組む必要はありません。C言語コントローラ設定・モニタツールのビ
ジュアルな画面を操作するだけで，簡単に作業が完了します。
また，各ユニットの状態，C言語コントローラユニットやユーザプログラムで発生したエラーなどの
確認，ケーブル断線や通信状態などの確認も，プログラムレスで可能です。

4. 手軽な統合開発環境「CW Workbench」でクイックスタート !
プログラムの編集から実行モジュールの生成，デバッグまでの基本機能を備えた C言語コントローラ
用エンジニアリングツール「CW Workbench」により，手軽に C言語コントローラユニットのユーザ
プログラムを開発できます。
また，Eclipse ベースの CW Workbench は，サードパーティ製のプラグインソフトにより機能拡張が
可能です。

int nRet;                   // 関数
DWORD nLen;                 //  バッ
ULONG ulBoardNo = 0;        //  ボー

//  ボード番号0 のボードを初期化
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf( "ボード番号0のボードが初
    printf("エラーコード : %d\n", n

int nRet;                                     // 関数
DWORD nLen;                         // バッ
ULONG ulBoardNo = 0;        // ボー

//  ボード番号0 のボードを初期化
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf("ボード番号0のボードが初
    printf("エラーコード : %d\n", n

/* Md.31  ステータス情報            
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x%0

/*  QD75 MまたはQD75M Hを指定している
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108  サーボステータス情報 
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

マイコンボードやパソコン環境 C言語コントローラシステム

またイチから
　プログラム
　　やり直し? Ethernet

/* Md.31  ステータス情報            
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x%0

/*  QD75 MまたはQD75M Hを指定している
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108  サーボステータス情報 
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

モニタ
C言語コントローラ設定・モニタツール

ビジュアルな画面でモニタや設定などが可能

/*  バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

パラメータ設定
/*  バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

モニタ
/*  バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

初期化
オール
イン
ワンコンパイル

プログラム作成／修正

ダウンロード

デバッグ

ミスや
変更があると
やり直し

初期化

すべて
プログラムが
必要

手順も
面倒

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;                   
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/*  書き込み判別処理               
if(sRet != 0){
    printf("Parameter area write er

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;                   
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/*  書き込み判別処理               
if(sRet != 0){
    printf("Parameter area write er

パラメータ設定

モニタ
テスト

診断・
エラー履歴

パラメータ
設定

プラグインにより,
メニュー項目などの多言語化や

ソースコード管理
なども可能！

Ethernet

CW Workbench

“Project Explorer”ウィンドウ

“Editor”ウィンドウ

“Remote Systems”ウィンドウ

“Breakpoints”ウィンドウ

“Debug”ウィンドウ

“Build Console”ウィンドウ

“Expressions”ウィンドウ

“Memory Browse”ウィンドウ

“Variables”ウィンドウ

“Registers”ウィンドウ

プロジェクトの管理，設定

C言語コントローラユニットへの接続操作

ビルド処理過程の表示

ローカル変数の現在値の表示

レジスタの現在値の表示 C言語コントローラユニット上のメモリダンプの表示

ウォッチ登録した変数の現在値の表示

パソコン

ブレイクポイント管理

デバッグ操作
プログラム編集
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5. パートナ製品の活用により用途拡大！
C 言語コントローラユニットに下記などのパートナ製品を組み合わせれば，さらに高機能で使いやす
い情報連携を行うことができます。

　(1) SECS 通信ソフトウェアパッケージ (CIMOPERATOR) との情報連携
CIMOPERATOR を導入すれば，パソコンレス，プログラムレスで上位サーバとの SECS 通信
(GEM*1 ／非 GEM) を実現でき，製造装置の状態管理や情報収集が可能になります。

          ＊ 1　半導体の製造ラインで使用される，業界標準通信プロトコルの 1つ。

　(2) ビジョンシステム (COGNEX In-Sight EZ, In-Sight 7000 シリーズ ) との連携
COGNEX ビジョンシステムと C言語コントローラユニットの連携により，製品の測定，検査，
識別など製造工程の自動化を簡単に実現できます。

参考

パートナ製品の詳細については，下記カタログを参照してください。
三菱 iQ Platform 対応 リアルタイムOS搭載 C 言語コントローラ：L( 名 )08144

マイコンボードやパソコン環境 C言語コントローラシステム

C言語コントローラユニットに
CIMOPERATOR実行モジュ
ールを実装するだけで，直接
SECS通信が可能！

ツール設定のみでGEM定義
が可能！
GEM規格以外でも独自フレ
ームを定義して通信可能！

C言語コントローラユニット
をSECS通信ゲートウェイ
とすることで，コスト削減＆
省スペース！

             日本電能株式会社

製造
装置

パソコンレスを実現

プログラムレスの
簡単設定

コストダウン・
サイズダウン

SDメモリカードにCIMOPERATORを
インストール

製造
装置

パソコン
レス

SECS通信

上位
サーバ

上位
サーバ

ゲートウェイ
パソコンに，
SECS通信
を行うプログ
ラムが必要

パソコン
が必要

SECS通信は
コストや手間が大変

パソコン
運用負荷

開発コスト
増大

ハングアッ
プ

故障

パソコン設置スペース要

膨大な通信プログラム

In-Sight EZシリーズ

In-Sight EZ-700
In-Sight 7000シリーズ

HUB

C言語プログラムによるコマンド送信により，
撮像や画像の取込み処理の実行が可能！

画像処理プロセッサ一体型の
マシンビジョンと連携！

Ethernet
接続可能
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関連マニュアル
本クイックスタートガイドでは，C言語コントローラユニットの基本的な導入手順を紹介しています。
C言語コントローラユニットを十分に活用するために，目的に応じて，下記のマニュアルをお読みく
ださい。

■ C 言語コントローラユニットについて詳しく知りたいとき

■ CW Workbench について詳しく知りたいとき

●MELSEC-Q C 言語コントローラユニットユーザーズマニュアル
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-081077

C 言語コントローラユニットのシステム構成，仕様，機能，取扱い，配線，トラブル
シューティング，および関数とプログラミングについて記載しています。

●C言語コントローラ設定・モニタツールオペレーティングマニュアル
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-081076

C 言語コントローラ設定・モニタツールのシステム構成，操作方法について記載しています。

●CW Workbench オペレーティングマニュアル  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-080981
CW Workbench のシステム構成，インストール／アンインストール，仕様，機能，トラブ
ルシューティングについて記載しています。

参考

最新のマニュアル PDF は，三菱電機 FAサイトから入手できます。
http://www.MitsubishiElectric.co.jp/fa/
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C言語コントローラユニットを使ってみよう
C 言語コントローラユニットは次のような手順で導入します。

〈1〉作業を行う前に (P.12)
　　　必要な機材を準備します。

〈2〉システムを構築する (P.13)
　　　準備した機材を設置して配線し，電源を入れます。

　　　1) システム構成例 (P.13)
　　　　　　本クイックスタートガイドの操作説明で使用するシステム構成例です。
　　　2) ユニットを装着する (P.14)
　　　　　　システムを構成するユニットを，ベースユニットに装着します。
　　　3) ユニットの配線を行う (P.15)
　　　　　　電源ユニットおよび出力ユニットへの配線をします。
　　　4) 電源が正常か確認する (P.17)
　　　　　　システムの電源を入れて，ユニットの状態を確認します。

〈3〉ユニットの設定をする (P.18)
　　　C言語コントローラ設定・モニタツールを使って， C言語
　　　コントローラユニットを動作させるための設定を行います。

　　　1) C 言語コントローラユニットを初期化する (P.18)
　　　　　　設定を行う前に，標準 RAMおよび標準 ROMを使用可能な状態にします。
　　　2) パラメータを設定する (P.20)
　　　　　　C言語コントローラユニットに，パラメータを設定します。

〈4〉プログラミングする前に知っておきたいこと (P.23)
　　　1) 専用関数ライブラリとは (P.23)
　　　2) 今回使用する専用関数 (P.24)

〈5〉プログラミングする (P.26)
　　　CW Workbench を使って，プログラムを作成します。

　　　1) プロジェクトを作成する (P.29)
　　　　　　CW Workbench を起動し，プロジェクトの作成と設定を行います。
　　　2) ユーザプログラムを作成する (P.33)
　　　　　　C言語コントローラシステムの制御を行うユーザプログラムを作成します。
　　　3) ユーザプログラムから実行モジュールを生成する (P.35)
　　　　　　作成したプログラムを，実行可能なモジュールに変換 (ビルド ) します。
　　　4) C 言語コントローラユニットと CW Workbench を接続する (P.36)
　　　　　　デバッグを行うために，C言語コントローラユニットと CW Workbench を接続します。
　　　5) ユーザプログラムをデバッグする (P.38)
　　　　　　作成したプログラムが正しく動作するか確認します。
　　　6) 実行モジュールを登録する (P.42)
　　　　　　プログラムを稼動用にビルドし，C言語コントローラユニットに格納します。

〈6〉動作を確認する (P.44)
　　　プログラムを実行し，動作を確認します。
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〈1〉作業を行う前に 
必要な機材を準備します。

＊ 1 あらかじめ，同じパソコンに C言語コントローラ設定・モニタツール (SW4PVC-CCPU)，CW 
Workbench をインストールしておいてください。

参考

C 言語コントローラ設定・モニタツールのインストールについては，下記マニュアルを参照し
てください。

C言語コントローラ設定・モニタツールオペレーティングマニュアル :SH-081076

CW Workbench のインストールについては，下記マニュアルを参照してください。
CW Workbench オペレーティングマニュアル：SH-080981

0
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4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

QY40P

⑤Ethernetケーブル

①C言語コントローラ
　システム

②パソコン ③C言語コントローラ
    設定・モニタツール
    (SW4PVC-CCPU)

④CW Workbench

Windows  パソコン

インストール*1

インストール*1

各ユニットについては
次ページにて説明

ストレートケーブルでも
クロスケーブルでも可



13

〈2〉システムを構築する

1) システム構成例
本クイックスタートガイドでは，下記のシステム構成を例に挙げて説明します。

＊電源ユニットへの配線は省略しています。

No. 名称 形名 説明

① ベースユニット Q33B
電源ユニット，C言語コントローラ
ユニット，入出力ユニットなどを
装着するユニットです。

② 電源ユニット Q62P
C 言語コントローラユニット，入出
力ユニットなど各ユニットに電気
を供給するユニットです。

③ C言語コントローラユニット Q24DHCCPU-V C 言語コントローラシステムの制御
を統括するユニットです。

④ 出力ユニット QY40P 出力機器と接続するユニットです。
この例ではランプと接続します。

⑤
接続ケーブル
(Ethernet ケーブル )

10BASE-T/100BASE-TX の
規格を満たす Ethernet ケーブル

C言語コントローラ設定・モニタ
ツールをインストールしたパソコ
ンと C言語コントローラユニット
を接続します。

⑥
接続ケーブル
(Ethernet ケーブル )

10BASE-T/100BASE-TX/
1000BASE-T の規格を満たす
Ethernet ケーブル

CW Workbench をインストールし
たパソコンと C言語コントローラ
ユニットを接続します。
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9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

QY40P

ランプ（出力）C言語コントローラシステム

①

④

②

③

⑤

⑥
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2) ユニットを装着する
準備したユニットをベースユニットに取り付けます。

C言語コントローラユニットを初めて使用する場合は，バッテリコネクタの装着が必要です。

●バッテリは，必ず装着して運転を行ってください。

●ユニットを取り付けるときは，必ず電源を遮断してください。

Point

●C言語コントローラユニットへのバッテリの装着方法

参考

ユニットの取り外し方については，下記マニュアルを参照してください。
MELSEC-Q C 言語コントローラユニットユーザーズマニュアル：SH-081077

C言語コントローラユニット

バッテリ

完　　了

バッテリに取り付けられているコネク
タをケース側のコネクタピンに方向
性を確認して差し込みます。

バッテリが正しく装着されているか確
認します。

C言語コントローラユニット底部のカ
バーを開けます。 コネクタ

コネクタ止め
余ったバッテリのリード線
は，バッテリの上部にまと
めて配置してください。

バッテリの
リード線

ユニット

ユニット固定穴

ユニット
固定用突起

ベースユニット

ユニット
装着用レバー

ユニットは，ユニット固定穴
を支点とし，矢印方向に“カ
チ”と音がするまで押してベ
ースユニットに装着します。

ユニットがベースユニットに
確実に挿入されているのを
確認してくだい。

完　　了

ユニット固定穴

ユニット装着用
レバー

ユニット固定用
突起*1

ベースユニット

ユニット固定用突起　
がユニット固定穴から
外れないように，確実に
挿入してください。

＊1

ユニット固定用
フック*2

ベースユニット

ユニットコネクタ
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3) ユニットの配線を行う
電源ユニットの配線を行います。

1. 電源ユニットへの配線をする
ベースユニットへの電源線，接地線の配線例を下記に示します。

接地は，感電，誤動作を防止するために行う配線です。

2. 出力ユニットへの配線をする
出力ユニット (QY40P) への配線例を下記に示します。

ユニットの配線を行うときは，必ず電源を遮断してください。

参考

配線についての注意事項の詳細については，下記マニュアルを参照してください。
QCPUユーザーズマニュアル ( ハードウェア設計・保守点検編 )：SH-080472

ERR

24V

24VDC
0.5A

24G

(FG)

(LG)

N

L

INPUT

～

ERR

②FG
②LG
①INPUT
100-240VAC

①電源入力端子に
　AC100Vの交流
　電源を接続

②LG,FG端子を接地

電源ユニット
(Q62P)

接地線
接地

AC100V

AC

ERR

24V

24VDC
0.5A

24G

(FG)

(LG)

N

L

INPUT

16
17
18

15
14
13
12
11
10
9
8
7
6
5
4
3
2
1

0 1 2 3 4 5 6 7
8 9 A B C D E F

QY40P

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
12VDC

0 . 1A

＋

ー

L

ランプ1
信号：Y00

L

ランプ2
信号：Y01
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Point

出力電源と C 言語コントローラシステム電源は，下図のように，系統を分離して配線を
行ってください。

AC100V
AC200V

主電源 中継端子台

C言語コントローラ
システム
電源 C言語

コントローラ
システム

出力機器

絶縁
トランス

制御盤内

出力電源
T1
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4) 電源が正常か確認する
システムの設置，ユニットの取付け，配線をした後に，電源が正常に入ることを確認します。

操作手順

1. 電源を入れる前の確認
・電源の配線
・電源電圧

2. C言語コントローラユニットの状態を STOPにする

3. 電源を投入

4. 電源が正常であるかを確認

C 言語コントローラユニット前面のカバーを開き，
「RUN/STOP/MODE」スイッチを「STOP」の位置に
します。

各ユニットの前面 LED を確認します。
正常な状態のときの LED 表示を下記に示します。
　① 電源ユニット：「POWER」LED が緑色点灯
　② C 言語コントローラユニット

：「MODE」LED が緑色点灯
　③ C 言語コントローラユニット

：「U RDY」LED が緑色点滅後，点灯

続いて，ユニットの初期化を行ってください。
「〈3〉ユニットの設定をする」(P.18)

以上で，システムの構築が完了しました。

Point

電源を投入しても電源ユニットの「POWER」LED が消灯している場合は，電源の配線，装着
が正しく行われているか確認してください。

参考

「ERR.」LED が点灯／点滅した場合は，下記マニュアルを参照してトラブルシューティングし
てください。

MELSEC-Q C 言語コントローラユニットユーザーズマニュアル：SH-081077

「RUN/STOP/MODE」スイッチ

③

②①
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〈3〉ユニットの設定をする
C 言語コントローラユニットを動作させるための設定を行います。

1) C 言語コントローラユニットを初期化する

操作手順
① ユニット前面のカバーを開け，「RESET/SELECT」ス
イッチを「RESET」側に倒します。

② LED が消灯していることを確認してください。

③「RUN/STOP/MODE」スイッチを「MODE」側に保
持し，「RESET/SELECT」スイッチを中央に戻します。

④「MODE」LED が " 橙色 " に点灯し，ドットマトリ
クスLED が"M-00"を表示していることを確認して
ください。

⑤「RUN/STOP/MODE」スイッチから手を離します。
スイッチが「STOP」位置に戻ります。

⑥ ドットマトリクスLEDに"0011"(初期化モード)が
表示されるまで，「RESET/SELECT」スイッチを
「SELECT」側に繰り返し倒します。

⑦「RUN/STOP/MODE」スイッチを「RUN」側に倒し，
初期化設定を実行します。
実行中は「RUN」LED が点滅します。

⑧「RUN」LED の消灯および，ドットマトリクス LED
の値が "0000" になったことを確認後，C言語コン
トローラユニットをリセットしてください。

初期化を行うと C 言語コントローラユニット内のデータが削除されます。
初期化を行う前に，必要なデータ，ユーザプログラムおよびパラメータのバックアップを
行ってください。
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⑨ C言語コントローラユニットをリセットすると，初
期化が実行されます。
「RUN」LED と「USER」LED が緑色点滅します。

⑩ 初期化が完了すると，「RUN」LED，「USER」LED の
点滅が終了し，「MODE」LED が緑色点滅します。

⑪ C 言語コントローラユニットをリセットしてくだ
さい。
初期化が正常完了した場合は，「RUN」LED，
「MODE」LED，「U RDY」LED が緑色点灯します。

Point

リセットの操作手順
① C言語コントローラユニット前面の「RESET/SELECT」スイッチを，
　「RESET」側に倒します。

②「MODE」LEDが消灯したことを確認します。
[リセット完了の状態]

③「RESET/SELECT」スイッチを中央位置に戻します。

スイッチを操作する際に，ドライバなど先のとがった道具を使用しないでください。
破損する恐れがあります。
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2) パラメータを設定する
C言語コントローラユニットに，パラメータを設定します。

1. C言語コントローラユニットとパソコンを接続する
C 言語コントローラユニットのシステム Ethernet ポート (S CH1) とパソコンを，Ethernet ケーブルで
接続します。

用語

パラメータ ：C 言語コントローラシステムを動作させるために必要な設定情報のことです。
C 言語コントローラ設定・モニタツールを使って，C言語コントローラシステ
ム内の各ユニットおよびネットワークの設定を行います。

接続の際には，C言語コントローラユニットとパソコンの IP アドレスを，同一セグメントに
設定する必要があります。本クイックスタートガイドでは，C 言語コントローラユニットの
システム Ethernet ポート (S CH1) の IP アドレスは，初期値 (192.168.3.39) を使用するため，
パソコン側の IP アドレスを "192.168.3. ＊ ( ＊：0, 3, 39, 255 以外 )" に設定してください。
また，パソコンのサブネットマスクを "255.255.255.0" に設定してください。
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F

COM

24VDC
0 . 1A

12VDC

QY40P

パソコン C言語コントローラ
ユニット

参考

IP アドレスの変更については，下記マニュアルを参照してください。
MELSEC-Q C 言語コントローラユニットユーザーズマニュアル：SH-081077
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2. パソコンでパラメータを作成する
操作手順

① C 言語コントローラ設定・モニタツールを起動する

[ スタート ] → [ すべてのプログラム ] → [MELSEC] → [C 言語コントローラ Ver.4] →
[C 言語コントローラ設定・モニタツール ] を選択します。

②プロジェクトを新規作成する

[ プロジェクト ] → [ プロジェクトの新規作成 ]

③ CCPU パラメータを設定する

プロジェクトビュー → " パラメータ " → "CCPU パラメータ " →「I/O 割付設定」タブ

Point

C 言語コントローラ設定・モニタツールが Version 4.02C 以降の場合は，CPU タイプにて
"Q24DHC-V" を選択してください。

参考

各設定画面および設定項目の内容は，下記マニュアルを参照してください。
C 言語コントローラ設定・モニタツールオペレーティングマニュアル :SH-081076
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3.  C 言語コントローラユニットにパラメータを書き込む
①接続先の C言語コントローラユニットを設定する

ナビゲーションウィンドウ → 接続先ビュー → "( 接続先データ名 )"

②パラメータを書き込む

[ オンライン ] → [CCPU 書込 ]

ボタンをクリック → ボタンをクリック

4. C 言語コントローラシステムのリセットを行う
書き込んだパラメータが反映されます。

Point

アカウント入力画面が表示された場合は，下記を入力してください。
・ユーザ名：target
・パスワード：password
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〈4〉プログラミングする前に知っておきたいこと

1) 専用関数ライブラリとは
専用関数ライブラリとは，C言語コントローラユニットに標準で実装されている関数です。各ユニッ
トの制御や動作状態の読出しなど，以下のような関数を用意しています。

1. バスインタフェース関数
　　(1) バスのオープン／クローズ

バスインタフェース関数を使用する場合は，プログラムの開始時にバスをオープンし，プログラムの
終了時にバスをクローズします。

バスのオープン／クローズ関数

　　(2) 入出力アクセス
入出力アクセスには，1点単位でのアクセスとワード単位でのアクセスがあります。

① 1 点アクセス：1点分の情報 ( スイッチのON/OFF，ランプの点灯／消灯など ) を扱う関数

1点アクセス関数の具体例

② ワード単位アクセス：ワード (16 ビット ) 単位分の情報 ( 数値，文字列など ) を扱う関数

ワード単位アクセス関数の具体例

●バスインタフェース関数
ベースユニットのバスを経由して，入出力ユニットやインテリジェント機能ユニットを制御
します。

● C言語コントローラユニット専用関数
C言語コントローラユニットの，動作状態，表示 LED などを制御します。

関数名 機能
QBF_Open バスオープン
QBF_Close バスクローズ

Point

バスのオープン／クローズ (QBF_Open/QBF_Close) 処理は，プログラムの最初と最後の 1回
のみ行ってください。
プログラムの最初と最後の 1回にすることで，通信性能を向上させることができます。

関数名 機能
QBF_X_In_BitEx 入力信号 (X) を 1 点読み出す。
QBF_Y_Out_BitEx 出力信号 (Y) を 1 点出力する。
QBF_Y_In_Bit_Ex 出力信号 (Y) を 1 点読み出す。

関数名 機能
QBF_X_In_WordEx 入力信号 (X) をワード単位で読み出す。
QBF_Y_Out_WordEx 出力信号 (Y) をワード単位で出力する。
QBF_Y_In_WordEx 出力信号 (Y) をワード単位で読み出す。
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2. C 言語コントローラユニット専用関数
　  (1) ユーザ LED 制御

ユーザ LED 制御には，C言語コントローラユニット前面の表示 LED 制御とドットマトリクス LED 制
御があります。

ユーザ LED 制御関数の具体例

2) 今回使用する専用関数
今回作成するプログラムには，出力アクセスとドットマトリクス LED 制御の基本的な専用関数を使い
ます。

・バスオープン：QBF_Open 関数

・クローズ：QBF_Close 関数

関数名 機能
CCPU_SetLEDStatus C 言語コントローラユニットの表示 LEDを制御する。
CCPU_SetDotMatrixLED C 言語コントローラユニットのドットマトリクス LEDを制御する。

参考

ここでは，最も基本的な専用関数を紹介しています。
上記のほかにも，ネットワーク経由でデバイスを読み書きできる MELSEC 通信関数がありま
す。
専用関数ライブラリの詳細は，下記ヘルプを参照してください。

C 言語コントローラ設定・モニタツール → [ ヘルプ ] → [ 関数ヘルプ ] → 
[C 言語コントローラ関数ヘルプ ]

データ型 引数 名称 説明 IN/OUT

short sUnit ユニット識別
ユニットを指定します。
(2: C 言語コントローラユニット ) 

IN

long* plPath バスのパス オープンされたユニットのバスのポイン
タを格納します。 OUT

データ型 引数 名称 説明 IN/OUT

long plPath バスのパス オープンされたバスのパスを指定します。 IN
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・出力アクセス：QBF_Y_Out_WordEx 関数

・ドットマトリクス LED 制御：CCPU_SetDotMatrixLED 関数

データ型 引数 名称 説明 IN/OUT

long plPath バスのパス オープンされたバスのパスを指定します。 IN

short sFlg アクセスフラグ アクセスフラグを指定します。
(0: 通常アクセス、0以外 : リザーブ ) IN

unsigned short usYNo 先頭出力番号
先頭出力番号 (Y) を指定します。
(16 の倍数を指定してください )

IN

unsigned short usSize 出力サイズ 出力サイズをワード単位で指定します。 IN

unsigned short * pusDataBuf データ格納先 出力データの格納先を指定します。 IN

unsigned short usBufSize データ格納先サイズ 0を指定します。( ダミー ) IN

データ型 引数 名称 説明 IN/OUT

unsigned short usLedMode 出力モード

ドットマトリクス LED への出力モードを
指定します。
リザーブを指定した場合、本関数は無処
理で正常終了します。
(0：ドットモード、1：ASCII モード、
 その他：リザーブ )  

IN

char* pcData LED データ LEDデータを指定します。 IN

参考

C 言語コントローラユニットで使用する C 言語および C++ 言語プログラムのデータ型には，
主に下記のようなものがあります。

データ型 ビット幅 呼称
byte 8 符号なし整数型
char 8 文字型
unsigned char 8 符号なし文字型
short 16 符号付き短長整数型
unsigned short 16 符号なし短長整数型
int 32

符号付き ( 倍長 ) 整数型
long 32
unsigned long 32 符号なし ( 倍長 ) 整数型
float 32 単精度実数型
double 64 倍精度実数型
void - -
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〈5〉プログラミングする
出力ユニットに接続したランプと C言語コントローラユニット前面のドットマトリクス LED を点滅
させるプログラムを作成してみましょう。

1. 今回作成するプログラムと制御内容
今回作成するプログラムでは，下記の制御を行います。

C言語コントローラユニットを RUNすると，出力ランプ Y00，Y01 が交互に点灯を繰り返します。
また，出力ランプの点灯に同期して，C言語コントローラユニット前面のドットマトリクス LED の 1, 
2 と 3, 4 が以下の図のように点灯を繰り返します。

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

F
E
D
C
B
A
9
8
7
6
5
4
3
2

1
0

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

出力アクセス

ドットマトリクスLED制御

交互に　　点灯

Y20

Y21
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2. ソースコード
ソースコードを下記に示します。
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1) プロジェクトを作成する

1. CW Workbench を起動する
操作手順
① [スタート] → [すべてのプログラム] → [Wind River]
→ [CW Workbench] → [CW Workbench] を選択しま
す。

② 起動後，ワークスペースの保存先フォルダを入力
します。
ここでは，"C:￥WindRiver￥workspace" とします。

③ ボタンをクリック

④ ボタンをクリック

CW Workbench のメイン画面が表示されます。

②

③

④

参考

・ 初期状態の各ウィンドウサイズやアイコンなど
の配置は，お使いのパソコンによって変わりま
す。本クイックスタートガイドに記載している
画面と違う場合は，各ウィンドウサイズを調整
してください。
・ 拡大したり消したりした各ウィンドウを初期状
態に戻すには，メニュー [Window]
→ [New Window] を選択してください。
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2. 新規プロジェクトを作成する
操作手順
① メニュー [File] → [New] →
 [Wind River Workbench Project...] を選択

②「Wind River VxWorks6.8」を選択

③ ボタンをクリック

④「Downloadable Kernel Module」を選択

⑤ ボタンをクリック
   

⑥ プロジェクト名を入力
ここでは，"Q24_SampleProject" とします。

⑦ ボタンをクリック

これで，プロジェクト作成が完了しました。

①

②

③

④

⑤

⑥

⑦
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3. プロジェクトのプロパティを設定する
作成したプロジェクトを，C言語コントローラユニットで実行可能なモジュールに変換 ( ビルド ) す
るための設定を行います。

(1) 使用するプロセッサを設定
① Project Explorer ウィンドウから作成したプロジェ
クトを選択し，メニュー[Project] → [Properties] を
クリック

② 画面左側のツリーから「Build Properties」を選択

③「Build Support and Specs」タブをクリック

④「Available and enabled build specs」で
「PENTIUM4gnu」のみをチェック

⑤「Debug mode」をチェック

(2) インクルードファイルを設定
①「Build Paths」タブをクリック

② ボタンをクリック

③ ボタンをクリック

用語

ビルド：プロセッサに応じたソースコードのコンパイル，インクルードファイルとのリンクを
行います。

Point

正式なシステム運用，稼動時は，「Debug mode」
のチェックをはずしてください。

①

② ③

④

⑤

②

①

③
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④「Select directory」画面から C言語コントローラユ
ニット専用のインクルードフォルダを選択
ここでは C 言語コントローラ設定・モニタツール
を"C:￥MELSEC"へインストールした場合のフォル
ダになります。

⑤ ボタンをクリック

⑥「Add include search path to selected build spec」
画面で選択したフォルダが指定されていることを
確認

⑦ ボタンをクリック

⑧「Include paths」で追加したインクルードパスが表
示されていることを確認

⑨ ボタンをクリック

⑩ ボタンをクリック後，下記のメッセー
ジが表示された場合は， ボタンをク
リック

これで，プロジェクトのプロパティ設定が完了し
ました。

④

⑤

⑥

⑦

⑧

⑨

⑩
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2) ユーザプログラムを作成する
C言語コントローラシステムの制御を行うユーザプログラムを作成しましょう。

下記 1. で示すユーザプログラムの作成は，本クイックスタートガイド専用のサンプルプログラムを使
用することで省略できます。サンプルプログラムを使用する場合は，2. から始めてください。

1. ユーザプログラムを作成する
操作手順
① Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー [New] →
[File] をクリック

②「File Name」に新規作成するソースファイル名を
入力
ここでは "Q24_Sample.c" と入力します。

③ ボタンをクリック

④ Editor ウィンドウで，出力ユニットへのアクセス
およびドットマトリクスLED制御するための「ソー
スコード」(P.27) を記述します。

ソースコードの記述が終了したら「3) ユーザプロ
グラムから実行モジュールを生成する」(P.35)
へ移ってください。

参考

本クイックスタートガイド専用のサンプルプログラムは，三菱電機 FAサイトからダウンロー
ドできます。

http://www.MitsubishiElectric.co.jp/fa/

Point

ファイル名は拡張子まで入力してください。
またファイル名に全角文字は使用できません。使
用すると，コンパイル時にコンパイルエラーが発
生します。

①

②

③



34

2.  サンプルプログラムを追加する
操作手順
① 今回作成したプロジェクトフォルダ直下に，本ク
イックスタートガイド専用のサンプルプログラム
を格納します。
"C:￥WindRiver￥workspace￥Q24_SampleProject"

② Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー [Refresh]
をクリック

③ 手順①で格納したサンプルプログラムがプロジェ
クトに追加されます。

これで，サンプルプログラムの追加が完了しました。

①

②

③
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3) ユーザプログラムから実行モジュールを生成する
作成したプログラムを，C言語コントローラユニットで実行可能なモジュールに変換 (ビルド ) します。

操作手順
① Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー［Rebuild
Project］をクリック

② メニュー [Rebuild Project] をクリック後，下記の
メッセージが表示された場合は， ボ
タンをクリック

プロジェクトのビルドが開始され，Build Console
ウィンドウにビルドの処理過程が表示されます。

③ Build Console ウィンドウで，"Build Finished..." が
表示されることを確認してください。

"Build Finished..." が表示されると，ユーザプログ
ラムの作成およびビルドは完了です。

①

②

③

Point

"Build Finished..."が表示されずエラーが発生した
場合は，エラー内容を確認してプログラムを修正
してください。
プログラムを修正後，再度「3) ユーザプログラム
から実行モジュールを生成する」(P.35) から実施
してください。
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4) C 言語コントローラユニットと CW Workbench を接続する
CW Workbench でデバッグを行うために，C言語コントローラユニットのユーザ Ethernet ポート
CH1 と CW Workbench を接続します。

操作手順
① C 言語コントローラユニットから VxWorks イメー
ジファイルを取得するために，エクスプローラを
起動し，アドレス欄に下記の形式で入力します。
ftp://192.168.3.3/SYSTEMROM/OS_IMAGEFILE/

「ログイン」画面が表示されます。

②「ログイン」画面で下記のユーザ名とパスワードを
入力
・ユーザ名　　：target
・パスワード　：password

③  ボタンをクリック

④ C言語コントローラユニットに格納されている
VxWorks イメージファイルを，「C:￥MELSEC￥
CCPU4￥CCPUTool」へコピーします。

⑤ Remote Systems ウィンドウ内の  をクリック

「New Connection」画面が表示されます。

⑥「New Connection」画面にて
「Wind River VxWorks 6.x Target Server
Connection」を選択

⑦ ボタンをクリック

Point

C言語コントローラユニットとパソコンで通信す
る場合は，双方で同じ VxWorks イメージファイ
ルを指定する必要があります。

①

②

③

④

Point

「C:￥MELSEC￥CCPU4￥CCPUTool」は，C 言語コ
ントローラ設定・モニタツールを「C:￥MELSEC」
にインストールした場合に作成されるフォルダ
です。

⑤

⑥

⑦
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⑧「Backend settings」の設定項目で，下記の内容を
設定
・Backend ：wdbrpc
・Processor ：Z5xx( ボタンをクリッ

クし，ツリーから選択 )
・IP Address ：192.168.3.3( デフォルト )
・Port ：空欄

⑨「Kernel image」で「File」を選択

⑩ ボタンをクリック

「Open File」画面が表示されます。

⑪ 手順④でコピーした VxWorks イメージファイルを
ツリーから選択 (C:￥MELSEC￥CCPU4￥
CCPUTool) し， ボタンをクリック

⑫ ボタンをクリック

⑬ Remote Systemsウィンドウで追加したターゲット
サーバを選択し， をクリック

⑭ をクリック後，Remote Systems ウィンドウの
下部に "connected - target server running" が表示
されると接続完了です。

⑧

⑨ ⑩

⑪

Point

"connected - target server running"が表示されな
い場合は，C言語コントローラユニットの電源が
正常に投入されていることを確認し，再度「「4)
C 言語コントローラユニットと CW Workbench
を接続する」(P.36) から実施してください。

⑫

⑬

⑭
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5) ユーザプログラムをデバッグする
作成したプログラムが正しく動作するか確認します。

1.  ユーザプログラムをC言語コントローラユニットにダウンロードする
デバッグを行うために，実行モジュールをC言語コントローラユニットのメモリにダウンロードします。

ダウンロードを行うと，スクリプトファイルがなくてもプログラムが実行できます。

① Project Explorer ウィンドウから作成した
モジュールファイル"Q24_SampleProject.out"を選
択して右クリックし，メニュー [Download
VxWorks Kernel Task] をクリック

「Download Configurations」画面が表示されます。

②「Launch Context」にて
「VxWorks6x_192.168.3.3 (Wind River 
VxWorks 6.8)」のみをチェック

③ ボタンをクリック

用語

スクリプトファイル：C言語コントローラユニットを立上げ時に起動するユーザプログラムの
ロード先，起動順序などを記述するファイルです。

①

Point

2 回目以降の②の操作では，
「Launch Configuration Selection」画面が表示さ
れます。
｢Launch the selected launch configuration ｣を選
択し， ボタンをクリックしてくださ
い。

②

③
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2.  ユーザプログラムをデバッグする
① Project Explorer ウィンドウから，作成したプロ
ジェクトを選択し，ツールバーの 右脇の を
クリック

② メニュー [Debug Configurations...] をクリック

「Debug Configurations」画面が表示されます。

③「VxWorks Kernel Task」からダウンロードしたモ
ジュール "Q24_SampleProject.out" をクリック

④ C 言語コントローラユニットとの接続を示すター
ゲットサーバをチェック

⑤ ボタンをクリック

「Entry Points」画面が表示されます。

⑥ デバッグを開始する関数(Q24_SampleTask)を選択

⑦ ボタンをクリック

⑧「Entry Point」に手順⑥で選択した関数名が設定さ
れていることを確認

⑨ ボタンをクリック

⑩ デバッグが開始され，「Entry Point」で指定した関
数の先頭でプログラムの実行が止まります。

②

①

③

④

⑤

⑥

⑦

⑧

⑨

⑩
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⑪ Debug ウィンドウの で，1 ステップごとにデ
バッグを行います。

⑫ 画面右下の「Variables」ウィンドウ *1 のタブをク
リックし，各変数の値の確認や変更を行うことが
できます。
ここでは "QBF_Open" 関数の戻り値である "sRet"
が 0( 正常値 ) であることを確認します。

＊ 1 お使いのパソコンによっては，「Variables」ウィン
ドウが下記のように表示される場合がありますの
で，ウィンドウサイズを調節してください。

手順⑪⑫で，作成したプログラム全体をデバッグ
します。

⑪

⑫

参考

バスインタフェース関数およびC言語コントロー
ラユニット専用関数の戻り値が 0 以外の場合は，
下記を参照してトラブルシューティングしてく
ださい。

C 言語コントローラ設定・モニタツール 
→ [ ヘルプ ] → [ 関数ヘルプ ] →
[C 言語コントローラ関数ヘルプ ]

MELSEC-Q C 言語コントローラ
ユニットユーザーズマニュアル：
SH-081077
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＜ Breakpoint を使用したデバッグ方法＞

左記⑪の 1 ステップごとのデバッグではなく，プ
ログラム内の任意の位置に Breakpoint を指定して
デバッグを進めることができます。

① ソースファイルの左端をダブルクリックし，
Breakpoint 挿入します。

②  をクリック

指定した Breakpoint の位置までプログラムが実行
されます。

⑬ Debug ウィンドウの をクリックし，デバッグ
を終了します。

①

②

参考

各アイコンの内容は下記のとおりです。
：1ステップ実行
1 ステップ単位で実行し，関数の場合は
当該関数の中に入りステップ実行を続け
ます。

：1関数単位実行
1 ステップ単位で実行し，関数の場合は
当該関数へは入らず関数単位でステップ
の実行を続けます。

：関数の最後 (Return) まで実行します。
：プログラム実行
：プログラム停止
：デバッグ終了

Point

再度デバッグを開始する場合は，ツールバーの
右脇の をクリックし，表示されたポップ

アップメニュー上部にある生成済みデバッグ構
成を選択することでデバッグを開始できます。
上記の手順①～⑩を省くことができます。

⑬
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6) 実行モジュールを登録する
作成したプログラムを稼動用にビルドし，C言語コントローラユニットに格納します。

操作手順

1. ユーザプログラムをビルドする
① Project Explorer ウィンドウから作成したプロジェ
クトを選択し，メニュー[Project] → [Properties] を
クリック

② 画面左側のツリーから「Build Properties」を選択

③「Debug mode」のチェックをはずす。

④ ボタンをクリック

⑤「3)ユーザプログラムから実行モジュールを生成す
る」(P.35) に従ってビルドします。

⑥ 下 記 の メ ッ セ ー ジ が 表 示 さ れ た 場 合 は，
ボタンをクリックしてください。

2.  ユーザプログラムを格納する
① エクスプローラを起動し，C 言語コントローラユ
ニットのアドレス欄を，下記の形式で入力します。
ftp://192.168.3.3/ROM

C言語コントローラユニットへログインすると，下
記のように表示されます。

② 作成したユーザプログラム "Q24_SampleProject.
out" をドラッグ＆ドロップで C 言語コントローラ
ユニットの標準 ROMへコピーします。
本クイックスタートガイドで作成したユーザプロ
グラムは，下記に格納されます。
C: ￥WindRiver ￥workspace ￥Q24_SampleProject ￥
PENTIUM4gnu￥Q24_SampleProject￥NonDebug

①

②

③

④

⑥

①

②
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3.  スクリプトファイルを作成・格納する
C 言語コントローラユニットを起動時に，実行モ
ジュールを自動的にロードするためのスクリプト
ファイルを作成します。

① テキストファイルを開き，下記のようにユーザプ
ログラムのロード，タスク生成を行うスクリプト
ファイルを記述します。

② ファイル名を "STARTUP.CMD" として保存します。

③ 作成したスクリプトファイルを，C言語コントロー
ラユニットの標準 ROMへコピーします。
ftp://192.168.3.3/ROM

これでスクリプトファイルの作成・格納は完了です。

参考

本クイックスタートガイド専用のサンプルプロ
グラムは，三菱電機 FAサイトからダウンロード
できます。

http://www.MitsubishiElectric.co.jp/fa/

C 言語コントローラユニット
クイックスタートガイド (Q24DHCCPU-V)  

L( 名 )08265

Point

ユーザプログラム，スクリプトファイルは標準
ROM以外に，SDメモリカードにも格納すること
ができます。
スクリプトファイルを両方に格納した場合は，
SD メモリカード内のスクリプトファイルが優先
的に起動します。

“Q24_SampleTask”関数を
デフォルトタスク名(t1)
で生成します。

“Q24_SampleProject.out”
ファイルを標準ROMから

ロードします。

③
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〈6〉動作を確認する
C 言語コントローラユニットへ登録したプログラムを実行し，動作を確認します。
操作には C言語コントローラユニット前面の「RUN/STOP/MODE」スイッチと「RESET/SELECT」ス
イッチを使用します。
［RUN/STOP/MODE スイッチの用途］
 ・RUN ：ユーザプログラムからの出力 (Y)，バッファメモリ書込みを許可
 ・STOP ：ユーザプログラムからの出力 (Y)，バッファメモリ書込みを禁止
 ・MODE ：ハードウェア自己診断機能などで使用

［RESET/SELECT スイッチの用途］
 ・RESET ：ハードウェアリセット，プログラムリセット
 ・SELECT ：ハードウェア自己診断機能などで使用

Point

C 言語コントローラユニットのプログラムの演算は，スイッチの状態が RUN/STOP にかかわ
らず実行されます。

参考

「RUN/STOP/MODE」スイッチおよび「RESET/SELECT」スイッチの詳細については，下記マ
ニュアルを参照してください。

MELSEC-Q C 言語コントローラユニットユーザーズマニュアル：SH-081077
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操作手順

1. ユーザプログラムからの出力 (Y) を許可

2. C言語コントローラユニットのリセットを実行

Point

「RUN/STOP/MODE」スイッチを「STOP」の位置にすると，ユーザプログラムからの出力 (Y)
は禁止されます。

参考

「ERR.」LED が点灯／点滅した場合は，下記マニュアルを参照してトラブルシューティングし
てください。

MELSEC-Q C 言語コントローラユニットユーザーズマニュアル：SH-081077

「RUN/STOP/MODE」スイッチ

MODE: 緑色 点灯
RUN : 消灯

MODE: 緑色 点灯
RUN : 緑色 点灯

① C言語コントローラユニット前面の「RUN/STOP/MODE」スイッチを
　「RUN」側に倒します。

②「RUN」LEDが緑色点灯すれば，正常にプログラムが実行しています。
    RUN状態時のLED表示

STOP状態時のLED表示

「RESET/SELECT」スイッチ

「RESET/SELECT」スイッチ

MODE: 緑色 点灯

MODE: 消灯

① C言語コントローラユニット前面の「RESET/SELECT」スイッチを，
　「RESET」側に倒します。

②「MODE」LEDが消灯したことを確認します。
    [リセット完了の状態]

[リセット中]

③「RESET/SELECT」スイッチを中央位置に戻します。
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3. ドットマトリクス LED，ランプを使って，動作を確認する
C 言語コントローラユニット前面のドットマトリクス LEDと出力ランプが，下記のように点灯します。

① C 言語コントローラユニット前面のドットマトリクス LED1, 2 と 3, 4 が，交互に 20 回，点灯を繰
り返します。

② ①に同期し，出力ランプ Y20 と Y21 が交互に点灯を繰り返します。

③ 再度，確認したい場合は，C言語コントローラユニットをリセットします。

参考

ドットマトリクス LED および出力ランプの状態は，C 言語コントローラ設定・モニタツール
でも確認できます。(P.47, P.50)

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

F
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Y21
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よく使う機能
C 言語コントローラユニットで，システム立上げ時や運用・稼動後の保守などによく使う機能を紹介
します。

〈1〉エラーを確認する
C 言語コントローラ設定・モニタツールを使って，発生したエラーの内容を確認できます。

1) エラーが発生した場合の確認方法

操作手順
① C 言語コントローラ設定・モニタツールで [ 診断 ]
→ [CCPU診断 ] を選択

② C言語コントローラ診断画面が表示されます。

③ 画面にエラーコードが表示されます。

④ 発生したエラーに該当するエラー項目が (赤 )に
なります。
モニタ中は常に最新のエラーコードに更新されます。①

③

④



48

2) 今までに発生したエラー履歴の確認方法
今までに発生したエラーの履歴と詳細情報を確認することができます。
いつ，どのようなエラーが発生したかを知ることができ，トラブルの解析に役立ちます。

操作手順
① C言語コントローラ設定・モニタツールを起動

② [ 診断 ] → [ イベント履歴 ] を選択

③ 今までに発生したエラーの履歴と詳細情報が表示
されます。

④ 詳細を知りたいエラーの行をダブルクリック

｢イベント詳細情報｣画面が表示されます。

⑤ または ボタンをクリック
すると，直前または直後のエラーの詳細情報に切
り替わります。

⑥ ボタンをクリックすると，選択して
いるエラーのヘルプが表示されます。②

③
④

⑤

⑥
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〈2〉ユニット状態のモニタと動作テストを行う
C 言語コントローラ設定・モニタツールを使って，ユニットの入出力やバッファメモリの状態が確認
できます。また，立上げ時や保守時などに，一時的な入出力の確認や動作テストができます。

1) ユニットの入出力とバッファメモリの状態の確認方法
ユニットの入力 (X)，出力 (Y)，バッファメモリの状態をモニタできます。

操作手順

1. C言語コントローラ設定・モニタツールで[オンライン]→[デバイスモニタ]を
選択

「デバイスモニタ」画面が表示されます。

用語

バッファメモリ ：インテリジェント機能ユニット (A/D，D/A 変換ユニットなど，入出力
以外の機能を持つユニット ) 内部の記憶領域で，C 言語コントローラ
ユニットと受け渡しするデータ ( 設定値，モニタ値など ) が格納され
ます。
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2. デバイスモニタ画面の確認

No. 名称 内容

① デバイス デバイス名を入力します。

② モニタ形式

モニタ形式を設定します。
ビット＆ワード： モニタ画面をビットおよびワード表示に設定します。
ビット多数： モニタ画面をビット表示のみに設定します。
ワード多数： モニタ画面をワード表示のみに設定します。

③ 表示 モニタ形式が，"ビット＆ワード "または " ワード多点 "時に，表示するデバイス値
の表示形式を設定します。

④ 数値 表示が "16 ビット整数 "または "32 ビット整数 "時の基数 (10 進／ 16 進 ) を設定しま
す。

⑤ ビット並び順
モニタ中のビットデバイスの並び順を設定します。
F-0: 左から F,E, ･･･ 1,0 の順に並びます。
0-F: 左から 0,1, ･･･ E,F の順に並びます。
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2) 強制出力による動作テストの実施方法
出力 (Y) の強制出力を行うことで，ユニットの動作テストを実施できます。ここでは，出力 (Y) の強
制出力の手順を示します。

操作手順

1. 「デバイス書き込み」画面で 　ボタンをクリック

2. 出力 (Y) の強制出力が実行されます。

Point

バッファメモリへの強制書込みによる動作テス
トも，同様の手順で行うことができます。
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Microsoft，Windows は，米国Microsoft Corporation の米国およびその他の国における登録商標です。
Ethernet は，米国 Xerox Corporation の商標です。
VxWorks は，米国ウインドリバー・システムズ社の登録商標です。
CIMOPERATOR は，日本電能株式会社の登録商標です。
その他，本文中における会社名，商品名は，各社の商標または登録商標です。
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